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Definição de SIG 1 

“Um Sistema de Informação Geográfica é um sistema baseado no computador 
que consiste em hardware, software, dados e usuários. Com ele dados 
relacionados ao espaço podem ser digitalmente coletado e alterado, 
armazenado e reorganizado, modelado e analisado assim como ser 
apresentado em forma gráfica.” (Bill u. Fritsch, 1991) 
 
O SIG tenta em modelar o mundo real onde diferentes fenômenos encontradas 
em cima, sobre ou em baixo da superfície terrestre são representadas por 
camadas de informação. Essas camadas de informação são relacionadas entre 
si através da localização geográfica (referência espacial): 
 

 
 

 
Os SIG permitem compatibilizar a informação proveniente de diversas fontes, 
como informação de sensores espaciais (detecção remota / sensoriamento 
remoto), informação recolhida com GPS ou obtida com os métodos tradicionais 
da Topografia. 
Entre as questões em que um SIG pode ter um papel importante encontram-se: 

1. Localização: Inquirir características de um lugar concreto. 
2. Condição: Cumprimento ou não de condições impostas aos 

objetos. 
Tendência: Comparação entre situações temporais ou espaciais 
distintas de alguma característica. 
3. Rotas: Cálculo de caminhos ótimos entre dois ou mais pontos. 

                                                      
1 Texto retirado de www.wikipedia.org.br, acesso em 27/11/2012 
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4. Modelos: Geração de modelos explicativos a partir do 
comportamento observado de fenômenos/fenômenos espaciais. 

 
Adicionalmente, um sistema de informações geográficas é composto por 
diversos componentes, a saber: 

1. Software/ Dados de entrada 
2. Hardware 
3. Métodos 
4. Brainware 

 

 

Descrição de dados no SIG 

O ponto de partida de um SIG é o Objeto Geográfico  que tem duas partes: 
1. Geometria  – a representação geométrica do objeto pode ser feita 

de duas formas: 
a. Representação vetorial 2: é um tipo de representação discreta 

que admite três formas, a saber:  
- Ponto: um ponto é um par ordenado (x, y) de 

coordenadas espaciais.  
- Linhas: as linhas são um conjunto de pontos conectados.  
- Polígonos: um polígono é a região do plano limitada por 

uma ou mais linha poligonais conectadas de tal forma 
que o último ponto de uma linha seja idêntico ao primeiro 
da próxima. 

  
b. Representação raster ou matricial  – dado que tem uma 

representação matricial de coordenadas (x,y). Seu elemento 

                                                      
2 Texto retirado de  http://www.ufpa.br/sampaio/curso_de_sbd/sig/cap02-conceitos.pdf, acesso em 

27/11/2012 
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básico é o pixel.
discreta. São Exemplos de 

- Modelo digital de elevação

- Temperatura 

 
- Imagem de satélite

 
- Dados esca
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básico é o pixel. A representação matricial pode ser contínua ou 
discreta. São Exemplos de representação matricial:

Modelo digital de elevação 

Temperatura  

 

Imagem de satélite 

Dados escaneados 
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A representação matricial pode ser contínua ou 
representação matricial: 
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2. Tabela de atributos : é uma planilha conectada à geometria (vetor e 
raster) que além de armazenar códigos de identificação contem 
informações adicionais das características de cada objeto 
geográfico. Por exemplo: um polígono “município” tem um nome, 
dados acerca de sua localização e outras variáveis. Em um arquivo 
vetorial de dados espaciais um objeto geográfico é representado 
por uma linha na tabela de atributos que obrigatoriamente vinculada 
a ele.  

Exemplo de aplicação de GIS 

Suponha que se deseje saber qual o habitat potencial de um animal. Dispondo 
de algumas informações básicas em GIS é possível “fazer perguntas” ao 
sistema, filtrando as respostas das bases de dados mediante critérios 
específicos até que seja obtida a resposta desejada. Esses tipos de análise de 
localização são um procedimento clássico de localização: cruzando várias 
camadas de informação espacial que representam fatores positivos ou 
negativos em relação à área desejada chega-se a localização que confere com 
todas as características desejadas. 
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Operações em GIS 

1. Buffer 3 
 

Buffer operation refers the creation of a zone of a specified width around a 
point or a line or a polygon area. It is also referred to as a zone of specified 
distance around coverage features.  

There are two types of buffers: constant width buffers and variable width 
buffers. Both types can be generated for a set of coverage features based on 
each features attribute values. These zones or buffers can be used in queries to 
determine which entities occur either within or outside the defined buffer zone. 
Analogous to buffering in raster GIS is distance analysis. 

An example of Buffering points 

A point is the basic unit of resolution in any GIS system. Buffering point data 
involves the creation of a circular polygon about the point of interest. The radius 
of this circular polygon is called the buffer distance. In this scheme the buffer 
distance or the radius of the circle could be fixed for all points in a layer or the 
user could specify it.  

 

If multiple point buffers intersect or overlap, as illustrated in Figure 1, then the 
system takes all the overlapping polygons and combines then into one or more 
polygons that represent a layer. This process of removal of overlapping 
sections involves the use of intersection and dissolves. In Figure 2, polygons A, 
B, and C describe the layer with all the eight points of interest. 

                                                      
3 A explicação sobre buffer foi extraída do site da Minnesota University: http://www-
users.cs.umn.edu/~npramod/enc_pdf.pdf 
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Example of line buffering: 

 

Example of polygon buffering: 
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2. Clip: recortar uma camada com extensão de outra camada. O programa, 
com operador de clip, recorta apenas a área de interesse. O clip recorta 
uma área com base na extensão de outra área, gerando um novo layer. 
O zoom é apenas uma operação visual. 

3. Intersect: une partes em comum de duas camadas distintas 
4. Union: soma de layers diferentes; 
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Ferramentas de Seleção  

Existem dois modos de selecionar um objeto geográfico: 

a) Por localização:  na figura, o polígono é selecionado se está 
compreendido em uma determinada área, mas existem vários outros 
operadores de seleção por localização entre duas ou mais camadas 
espaciais: 

 
 

b) Por atributos: permite a seleção de objetos geográficos através de 
determinadas características comuns na tabela de atributos. É como 
uma seleção em um banco de dados tabulares, mas como cada linha na 
tabela de atributos representa um objeto geográfico esses objetos são 
selecionados automaticamente. 
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Conceito do pacote ArcGIS (família ArcGIS) 

Alguns tópicos sobre a família ArcGIS: 

• A versão atual é a 10.1 
• ArcGIS Desktop: é a pacote mais comum, mas existem vários softwares 

que tem a mesma base de programação.  
• ArcIMS: servidor de dados espaciais usado para disponibilizar em rede e 

para visualização via browser  
• ArcSDE: faz interface entre visualizador e banco de dados – Oracle. 
• ArcGIS Desktop: contém vários módulos.  

- ArcMap (visualização de dados, desenho de mapas), o mais 
usado; tem integração com os demais módulos 

- ArcCatalog (administração de dados espaciais) 
- ArcToolbox (ferramentas de manipulação e análises),  
- ArcScene (visualização em 3D) 
- ArcGlobe (visualiza sobre o globo) 
- ArcDesktop administrador (administração das licença) 

• Extensões do ArcGIS: o ArcGIS possui ainda alguns módulos que 
contém funções adicionais, a saber: 

- 3D Analyst 
- Spatial Analyst 
- Geostatistical Analyst 
- ArcHydro (disponível gratuitamente) 
- ... 

• Versões de licenciamento 
- ArcView – visualização de mapas, análises básicos 
- ArcEditor – edição avançada de dados geográficos 
- ArcInfo – integração com banco de dados, topologia e outras 

funcionalidades avançadas 
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Treinamento com Exemplos 

Antes de começar o treinamento, é importante entender a definição de 
shapefile. 

Obs: Um shapefile são vários arquivos interdependentes.  

Conforme a definição da ESRI4 

“An ESRI shapefile consists of a main file, an index file, and a dBASE table. 

- The main file is a direct access, variable-record-length file in which 
each record describes a shape with a list of its vertices.  

- In the index file, each record contains the offset of the corresponding 
main file record from the beginning of the main file.  

- The dBASE table contains feature attributes with one record per 
feature. The one-to-one relationship between geometry and attributes 
is based on record number. Attribute records in the dBASE file must 
be in the same order as records in the main file. 

Exemplos:  

- Main file: counties.shp 
- Index file: counties.shx 
- dBASE table: counties.dbf 

Vamos agora trabalhar com os seguintes dados de exemplo dos estados 
da região sul: 

1. Baixe os dados do IBGE para uma pasta chamada IBGE: 
 

- Malha georreferenciada dos setores censitários do censo 2010: 
http://www.ibge.gov.br/home/download/geociencias.shtm, 
malhas_digitais => censo_2010 => setores_censitarios 

o PR.zip 
o SC.zip 
o RS.zip 

- Base de dados do questionário básico (universo) por setor censitário do 
censo 2010: http://www.ibge.gov.br/home/download/estatistica.shtm, 
Censos => Censo_Demografico_2010 => Resultados_do_Universo => 
Agregados_por_Setores_Censitarios 

o Base_informacoes_setores_2010_universo_PR.zip 
o Base_informacoes_setores_2010_universo_SC.zip 
o Base_informacoes_setores2010_universo_RS.zip 

                                                      
4 Retirado de http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf, acesso 28/11/2012 
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2. Baixe os dados do SWERA da irradiação solar para uma pasta chamada 
SOLAR: 

 

• BrazilTilted10km_289.zip, baixado em 
http://en.openei.org/datasets/node/513 

3. Descompacte todos os arquivos 
4. Abra o ArcCatalog do ArcGIS 

Dentro do ArcCatalog procure a pasta em que está a pasta IBGE. 
Abrindo essa pasta no ArcCatalog, se vê apenas o shapefile, pois é o único 
arquivo na pasta com o qual o ArcGIS trabalha diretamente (os demais não 
aparecem, ex. não aparece pdf, zip, etc, pois o programa não tem interface 
com essas extensões). Note também que os shapefiles são visualizados como 
sendo um arquivo só, mas olhando na pasta se vê os outros arquivos 
interdependentes do .shp também. 

Atenção! 

A mudança do nome do arquivo utilizando a interface Windows Explorer 
dá erro de abertura (Erro!). Para evitar esse problema, utilize a interface do 
próprio ArcCatalog, pois isso garante que os demais arquivos ligados àquele 
também tenham seus nomes alterados. 
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5. Clique na aba Preview para permitir a visualização dos dados. Use as 
ferramentas na barra Geography para navegar na geometria. Mude o 
conteúdo da visualização em baixo selecionando Geometry ou Table. 

 

 
 

6. Agora abra o ArcMap (INICIAR => Programas => ArcMap). É a parte com a 
qual vocês mais vão trabalhar. 

• Na Table of Contents (à esquerda da tela) há a listagem das camadas 
• Add Data > Abrir pasta SOLAR > Abrir arquivo com extensão .shp. 
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- Aparece o mapa do Brasil com a divisão de células de 10 em 10 km com 
a irradiação solar no plano inclinado. 

- A barra de ferramentas Tools contem várias ferramentas básicas como 
de navegação p.ex. 

- O botão azul Identify pode ser usado para obter mais informações sobre 
uma determinada célula – clique nela e depois na célula 

- Régua – permite saber a distância entre dois pontos do mapa 



TerraGIS 
Wolfram Johannes Lange 

Mapeamento da área potencial de telhados de 
edificações residenciais no Brasil para fins de 

aproveitamento energético fotovoltaico 
 

15 

 

7. Clique direito no nome da camada e depois em Open Attribute Table para 
abrir a tabela de atributos. Aqui a tabela pode ser visualizada, consultada e 
editada. 
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8. Agora se deseja visualizar a distribuição da irradiação conforme descrita na 
coluna “ANNUAL” do arquivo brazil_solar_tilted_10km2, faça o seguinte: 
- Clique direito no nome do layer => Properties  
- Abre-se um pop-up 
- Escolha a aba Symbology 
- Para visualizar os quadrados da irradiação solar dependendo de um dos 

atributos da tabela selecione  
Quantities e Graduated Colors  

- Em seguida selecione o campo da tabela que contem o valor que quer 
visualizar, ANNUAL no nosso caso, e escolha a faixa de cores desejada. 

 

- O ArcMap aplica por padrão uma classificação em cinco classes usando 
a metodologia de dividir as classes que se chama Natural Breaks. Para 
alterar a classificação, vá em Classification e definir  o número de 
classes, isto é, o número de faixas de valores para o qual o mapa deve 
exibir uma legenda. 

- Vá em Classification method e seleciona o método desejado ou altera 
manualmente a divisão das classes. 

- Para o exemplo foram utilizadas 5 classificações.Na janela Classificação 
é possível delimitar os break value. Adicionalmente, clicando em cada 
valor de classificação é possível mudar o valor dos break values para ter 
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classes com o mesmo intervalo (no exemplo foram utilizados passos de 
200) 

 

- Ao editar os números de Break Values, o campo Classification Method 
muda automaticamente para Manual. 

- Para mudar cores: botão direito do mouse no caixa de cada cor na Table 
of Contents ou clicar direito no nome da camada => Properties => 
Symbology => selecione a Color Ramp desejada. 

- Para mais informações sobre a classificação por cores graduados, abra 
a ajuda do ArcMap, busca por classifying graduated symbology na aba 
Search e lê a matéria Classifying numerical fields for graduated 
symbology 
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9. Vamos agora para os dados do censo demográfico 2010 do IBGE . 
- Já descompactamos os arquivos ZIP. 
- O arquivo Descrição_PR contém comentários sobre os setores 

censitários, cujas coordenadas encontram-se no arquivo .shp. Exemplo: 
o setor 23 tem uma linha férrea cujo nome consta do Descrição_PR. 
Assim se sabe qual onde começa e termina um determinado setor 
censitário. 

- O Arquivo “BASE DE INFORMAÇÕES POR SETOR CENSITÁRIO 
Censo 2010 - Universo.pdf” contém a explicação das variáveis avaliadas 
pelo censo conforme setor censitário. Especificamente, contém a 
espécie de domicílio (pág.18 do Arquivo Universo), tipologia das casas 
(pág. 20 do Arquivo Universo).  

- Na pág. 45 há a descrição das colunas do Arquivo Domicílio. Esse 
arquivo contém mias de 200 colunas, pois cada uma delas representa 
uma combinação possível para os domicílios, cuja classificação varia de 
acordo com a renda dos moradores, se é casa ou apartamento, etc. 

- No ArcCatalog clicar em 41SEE250GC_SIR.SHP. Na aba Preview (barra 
inferior) visualize a tabela com códigos e nomes das unidades 
territoriais. Os arquivos que contem SEE são os shapefiles com os 
setores censitários. 

- Arraste do ArcCatalog o shapefile 41SEE250GC_SIR.SHP para o 
ArcMap. O sistema fará a visualização por setor censitário do Paraná 
sobre a camada da irradiação solar. Note que a ordem da visualização 
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no mapa é a mesma do que na Table of Contents. Essa ordem pode ser 
alterada pegando e arrastando uma camada para cima ou para baixo na 
Table of Contents. 

- Ferramentas: 
o Zoom to layer 
o Zoom to selected feature (por exemplo para localizar um 

bairro do Paraná) 
 

 Capacitação Parte II – 26/11/2012 

1. Carregamento do shapefile no ArcMap contendo os municípios e como 
uma das informações na tabela de atributos a distribuidora por cada 
município. 

- Para edição o usuário deve clicar em editor (barra superior à 
direita) e Start Editing para poder editar a tabela de atributos 
(usamos isso para tirar espaço extra na frente da palavra 
COELBA) 

2. Para agrupar áreas com uma característica em comum, use a ferramenta 
Dissolve que se encontra no menu Geoprocessing. Escolhe o arquivo de 
entrada (no exemplo, o arquivo distribuidoras) e o critério de agrupamento 
(dissolve_field(s) Optional), o campo contendo o nome das distribuidoras 
nesse caso. 

- Depois disso escolha o campo para variáveis que devo analisar: 
o NUM_CONSUM 
o ID_UF 

- Algumas funções: 
o RANGE (calcula a diferença entre dois valores máximo e 

mínimo) 
o COUNT 
o SUM 

- Salve as alterações em novo arquivo com mesmo formato (.shp), 
para isso clique em Output Feature Class, pasta amarela à direita, 
um pop-up será aberto e então salve seu arquivo com outro 
nome. 

- Vamos agora calcular a delimitação de áreas. 

> Abro o shapefile do Paraná – 41MUE250GC_SIR 

> Escolho melhor visualização das áreas da concessionária 
(com cores diferenciados usando a opção Categories e Unique 
Values na aba Symbology das Properties da camada das 
concessionárias). 
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3. Seguimos trabalhando com o shapefile dos setores censitários e criaremos 
uma camada que contem as informações sobre os domicílios.  

- Abra o Domicilio01_PR e extraia essa tabela para a sua pasta de 
.shps. Com o ArcCatalog abra a tabela. 

- Agora adicione a tabela ao mapa .mxd e abra o arquivo. A tabela 
aparece com uma das colunas (Cod Setor) em floating point, o que não 
permite a correta visualização dos dados. 

- Para fazer a união das duas tabelas temos que corrigir esse problema. 

ATENÇÃO: Extensões .xls não podem ser editados pelo ArcCatalog.  

Então Para corrigir a questão do ponto flutuante: 

• Abro então o xls no Excel, altero o campo  
• Salvo em dbf 
• Abro no ArcMap 
• Crio uma nova coluna no ArcMap 
• Adiciono o texto 
• Agora ele deve estar com o tipo de variável correta.  

 

4. Ferramenta Join Data 
- O objetivo é unir as bases da geometria com as variáveis do Paraná 
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- Com os setores censitários adicionados na Table of Contents clique direito 
no nome da camada e em Join 

 

- Selecione o campo CD_GEOCODI da camada dos setores, depois vá para 
a tabela gerado no passo em cima que contem as variáveis e selecione o 
campo que contem o código dos setores em formato texto que criamos. 
Clique em OK. 
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- Verifica na tabela de atributos se o Join foi realizado. Depois dos atributos 
do shapefile devem aparecer os campos da tabela externa. Note que o Join 
vincula só temporariamente a tabela externa à tabela do shapefile. Para 
ficar com um shapefile com todas as variáveis deve-se exportar como novo 
shapefile a camada com a tabela conectada. Com isso feito, quero agora 
selecionar apenas algumas colunas da tabela do IBGE 

5. Vou em Add Field e crio uma coluna para cada variável de que preciso. 
Pone o nome desejado e defina o tipo de dado que quer colocar. 

- Depois queremos popular as novas colunas com os valores das variáveis 
de Domicílio01 que precisamos. Clique direito no nome da coluna DomAP 
e selecione Field Calculator.  
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- No Field Calculator adicione com um Double Click o campo V005 
(Domicílios particulares permanentes do tipo apartamento) na parte branca 
da janela e clique OK para copiar os valores do campo V005 para o campo 
DomAP. 
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6. Depois de calcular todos os campos desejados, desfaça o Join: Clique 
direito na camada dos setores => Joins & Relates => Remove Joins e 
selecione o Join que quer desfazer. 

 

- Com isso foram excluídas todas as colunas desnecessárias 
 

7. Vamos calcular agora a irradiação por setor censitário.  
- Para isso use a ferramenta Spatial Join, dentro da ArcToolbox.  
- Para localizá-la facilmente, digite Spatial Join o campo de busca. A 

ferramenta permite agregar valores dos atributos de objetos geográficos 
de uma camada para objetos geográficos de outra camada dependendo 
da sobreposição deles. Os valores a serem completados para fazer o 
Spatial Join são: 

- Target Feature é a camada que conterá as unidades 
territoriais aos quais os outros valores vão ser atribuídas, 
os setores censitários nesse caso. 

- Join Features: é o valor da irradiação, a camada que 
contem os valores a serem atribuídos aos setores 
censitários. 

- Defina a camada e o lugar do shapefile de saída. 
- Da lista de atributos das duas camadas, Field Map of Join 

Features elimine todos os campos que não precisa na 
camada de saída. No nosso caso o código do setor 
censitário, os números dos domicílios e ANNUAL tem que 
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ficar. O campo ANNUAL é 0 que queremos agregar aos 
setores. 

- Clique direito em ANNUAL e seleciona MEAN para 
calcular a média das cédulas que sobrepõem cada setor 
censitário. 

 

- Match Option: Intersect (pois quero saber quando um dado 
setor censitário cruza com uma célula).  

Atenção: para fazer o Spatial Join, precisa-se que os dois shapefiles tenham o 
mesmo tipo de projeção, isto é, o sistema de coordenadas dos dois mapas 
deve ser idêntico. 

Veja que as duas tabelas tem projeções diferentes: clique ecom botão direito 
nas tabelas, vá em Properties e veja detalhes das duas distintas projeções. 

 

Para projetar: Em ArcToolbox, busque a ferramenta Project. A seguir, crie um 
arquivo SolarPR_PROJ. Os dados a serem preenchidos na janela do Project 
são: 

- Input DataSet: o setor censitário – 41SEE250GC_SIR 
- Input Coordinate: ENTRA AUTOMATICAMENTE 
- OutputDataSet: SetCens_PR 
- Output Coordinate System: para a escala do Brasil inteiro é 

recomendável Continental => South_American 
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- Salve os dados 
1. Faça o mesmo para os dados da irradiação 

Para selecionar os dados você pode clicar diretamente no nome da tabela à 
esquerda e arrastá-la para o campo desejado 

 

8. Para calcular agora a área aproveitável de telhados deve-se seguir os 
mesmos passos já feitos quando adicionaos e copiamos os dados dos 
domicílios para as novas colunas. Use o Field Calculator tanto para calcular 
a área aproveitável dos cenários tanto para depois criar e calcular a 
irradiação nessas áreas.  

9. Faça esses passos para as demais camadas dos setores censitários dos 
respectivos estados. 

10. Para unir shapefiles criados use a ferramenta Merge no menu 
Geoprocessing: 
- Tem três shapefiles, uma para cada estado da região sul: RS, SC e PR 
- Arquivos de entrada são os três shapefiles 
- Defina o arquivo de saída: SetCens_SUL 
- Clique em OK para executar 

 

 

11. Para agregar os valores por municípios ou estados use a ferramenta 
Dissolve. 
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12.  Para ver a área de telhados total: 
- Abra a tabela de atributos.  
- Clique em cima do nome da coluna que contem os dados que quer 

resumir.  
- Selecione Statistics e vê o resultado na janela que abre. 

13. Para ajustar a nomenclatura das faixas na Symbology crie uma coluna com 
1000000000 e normalize todos os valores (escolhendo em Properties, 
normalize e coloque a coluna que contem o fator. 

14. Para fazer um layout final e exportar em outro formato: 
- Clique no menu View => Layout View para mudar para o modo de 

desenho de mapa. 
- Ajuste o tamanho do map view que contem os dados usando os 

quadrinhos azuis. 
- Para adicionar uma legenda vá no menu Insert e selecione Legend. 

Siga os passos do wizard para adicionar a legenda ao desenho de 
mapa. Modifique o tamanho e a localização da legenda depois na folha 
do desenho. 

- Para adicionar uma flecha norte vá em Insert e selecione North Arrow. 
Siga os passos do wizard. Modifique o tamanho e a localização da 
flecha norte depois na folha do desenho. 

- Para adicionar uma barra de escala vá em Insert e selecione Scale Bar. 
Siga os passos do wizard. Modifique o tamanho e a localização da 
Scale Bar depois na folha do desenho. 

- Para exportar o desenho pronto vá ao menu File => Export Map. 
Selecione o lugar de saída, tipo de arquivo e resolução. Exporta 
clicando OK. 


